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Introduction
How to fully integrate a sample library into a DAW

There was never a more convenient way to tap the full potential of the Vienna Symphonic Library.
The Articulate Tools described in this manual integrate the Vienna Symphonic Library (VSL),
powered by Articulate Presets, into Logic. They consist of several different parts that seamlessly
work together to provide an unprecedented user experience, that literally puts the entire VSL at your
fingertips!

This manual describes this integration of the VSL into Logic, which offers the following features:

load instruments with all necessary settings and tools conveniently via Logic’s patch browser

full overview of the entire content of the VSL with all articulations and the assignments of all
controllers offered by Articulate Presets right where you need it: in Logic’s Main Window!

next-generation key switching that allows you to instantly access all articulations included in the
VSL via the novel concept of Articulation Banks

a Quick Access bank for the most important articulations following Babylon Waves universal Art
Conductor layout, compatible with nearly all libraries of other developers on the market

all articulations are automatically encoded in the note events themselves via Logic’s convenient
Articulation ID feature, and even main variations are directly accessible without other Midi events

the Articulate Sequencer which allows you to play and record realistic musical lines with
complicated articulation switches in real time: you only play the notes while this unique
articulation sequencer takes care of all the articulation switching

This functionality is provided by the following components (making up the Articulate Tools):

Articulate Macro: global Logic Environment Macro

Articulate Monitor: Smart Controls panel in Logic’s Main Window

Articulate Scripts: for Logic’s Scripter Midi Effects Plug-In for the different instruments / libraries
Articulate Sets: Logic Articulation Sets for the different instruments / libraries

Articulate Patches: Logic patch settings for every VSL Instrument / Articulate Preset

All of this might sound complicated, but in practice you don’t have to care about the entire
implementation at all, since all of these components are automatically set up whenever you load a
patch and seamlessly work together. Due to the dedicated patches you can conveniently add
instruments to your work via Logic’s patch browser (or remove them again) and everything is set up
and works automatically!
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Setup

What you need to do to get started

There is a dedicated Installer that automatically installs all components required by Articulate Tools.
Just double-click it and follow the steps. It installs this manual in your Music folder and all
components into the standard Audio Music Apps folder within it. Once installed, when you start a
new Logic project you should find several templates in the Articulate Templates folder that specify
which external Midi events, i.e. notes and Continuous Controllers (CC) (standardly all on Midi
channel 1), are used to control Articulate Tools...

® o Choose a Project

New Project
@ Recent

fiif Starter Grids

~=| Tutorials Articulate Artist Modest Maestro Piano Purist

Demo Projects

ﬁ Project Templates

My Templates

Articulate Temp...

Articulate Artist

P Details

Open an existing Project... Cancel Choose

Articulate Artist: requires a second 2-octave keyboard (25 keys) exclusively for key-switching

The small second keyboard should send on the two lowest octaves of the Midi standard, which is
even below the key range of a piano keyboard, so just transpose it downwards as far as possible.
The lower octave (C-2-B-2) switches banks, the upper octave (C-1-B-1) articulations. The remaining
key (CO) controls the Articulate Sequencer: single presses toggle between play and pause; “double-
clicking” it (i.e. pressing it twice in a row without pressing a normal keyboard key on your main
keyboard in between) toggles record on/off; “triple-clicking” stops the sequencer and resets it to
step one.

Piano Purist: requires a full piano keyboard (88 keys)
The lowest or highest full keyboard octave acts as a control key range and selects either
articulations or banks. The three lowest keyboard keys, which are very rarely used in an orchestral
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context (only the Contrabass Tuba & Trombone (AQ), Contrabassoon (A#0) and Basses (BO) reach
down that low), are permanently assigned as control keys and cannot be used for normal playing.
The lowest keyboard key (AO) is assigned as a bank-switch, that allows you to select banks instead
of articulations while it is pressed (similar to a modifier key on your computer keyboard). The second
lowest key (A#0) toggles the control key range between the lowest (C1-B1) and highest (C7-B7) full
octave. The third lowest key (BO) in turn controls the Articulate Sequencer (as described in detail in
the “Articulate Artist” paragraph). In case you need the lowest keys and instead want to use piano
pedals to control the Articulate Tools, see the Articulate Macro section.

Modest Maestro: requires only a basic 5-octave keyboard (61 keys), sustain + additional pedal

The lowest or highest keyboard octave acts as a control key range and selects either articulations or
banks. The sustain pedal (CC64) acts as bank-switch and selects banks while pressing and holding
(like a modifier key on your computer keyboard); “double-clicking" it (i.e. pressing it twice in a row
without pressing a normal keyboard key in between) flips the control key-range between the lowest
(C2-B2) and the highest octave (C6-B6) on the keyboard. The second switch pedal or button
(sending CC65) controls the Articulate sequencer (see the “Articulate Artist” paragraph).

All three templates are available in an empty version and in the Symphonic Cube or Basic Orchestra
also in a version (distinguished by a “+” or “-“ sign) that already includes all instruments of a basic
orchestra. If one of these templates matches your control hardware, everything should work out of
the box and there is nothing to set up. Yet, these are just a few standard examples and you can fully

adapt Articulate Tools to your hardware as described below in the Articulate Macro Section.

In case your keyboard has more or even less than 5 octaves, please adjust Library

the two key ranges via the corresponding text faders (“Lo-Art-Hi”) on the
Articulate Macro. Similarly, if your Midi keyboard has a whole range of
buttons, drum pads or similar, you can assign up to five of them instead of
the pedals to control Articulate Tools even more conveniently, see the
corresponding section on the Articulate Macro for details. If you only have a

small keyboard and no switch controllers you need to get some if you want
to use the key-switching and/or the sequencer—already a simple
Smartphone App can do the trick!

Depending on the chosen template you might also have to configure your
control hardware to send the appropriate switch controllers discussed
above, as well as the four dedicated controllers Articulate Presets use
(Vertical controller CC2, Horizontal controller CC3, Section controller CC20
and the A/B switch CC4).

You can now add orchestral instruments conveniently via Logic’s patch
browser (shown on the right), which can be accessed selecting View >
Show Library (Y). Everything can be controlled via the corresponding control
keys and/or switch controllers discussed above. And you always have
complete overview of the available articulations and banks, the selected
articulation and the effect of the four dedicated controllers used by
Articulate Presets via the Articulate Monitor, which you can access selecting
View > Show Smart Controls (B).

Page 6 of 32

Alto Flute

Bass Clarinet
Bass Trombone
Bass Trumpet
Basses M
Basses S
Bassoon

Bells

Cellos M

Cellos S
Cimbasso
Clarinet

Contra Bassoon
Contrabass Trombone
Contrabass Tuba
Cymbals & Gongs
Drums

English Horn
Flute
Glockenspiel
Harp

Horn

Horns L

Mallets

User Patche > Articulate Patches >

-3 Revert Save...



Features of Articulate Tools
How to integrate the VSL into Logic

Articulate Tools provide a complete integration of the VSL into Logic. As mentioned before, even
though the implementation relies on different components you generally do not have to worry about
the individual tools, but you will experience a seamless and coherent integration. In this section we
describe the general features and the handling, whereas further details are deferred to the individual
sections covering the particular tools.

Articulate Patches and Articulate Monitor

Instead of loading an Articulate Preset in Vienna Instruments pro (VI pro), you just add the Articulate
Patch for the corresponding instrument via Logic’s convenient Patch Browser. In addition to
instantiating the Vienna Instruments player and loading the corresponding Articulate Preset this also
adds other components (Articulate Script, Articulate Set, ...) to enable the comprehensive
functionality of Articulate Tools. Therefore, as soon as you have loaded a patch everything is
automatically set up and you can use all the features described in detail below, ranging from key-
switching and Articulation IDs to the sequencer.

You do not even have to open the Vienna Instruments player at all, unless you want to perform
special editing, since you get full overview of the current Articulate Preset and its features directly in
Logic’s main window via the Articulate Monitor. The left part shows the active Articulation Bank,
described below, the middle part the available articulations within this bank, the active articulation
(marked by a check mark) and the keys to access them. The right part shows in detail which effect
the different main continuous controllers (Vertical Controller CC2, Horizontal Controller CC3, Section
Controller CC20 and A/B switch CC4) used by Articulate Presets have for the selected articulation.
Finally the two top right panels show the status of the Articulate Sequencer, described below.

78: short por. . 84: fluttertongue

77: long por. 83: light dyn.
76: 82:
75: dyn. spec. 81: strong dyn. 2 players auto
VII: muted basic 74: --- 80: staccato mute strength

o 73: sustained 79: ---

Articulation Banks & next-generation key-switching

Standardly Articulate Presets allow you to conveniently access all articulations included in the VSL
via 128 program change messages and all the different versions of an articulation by additional
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continuous controller events. However, it takes time to enter a 3-digit program change number and
therefore this is harder to do during live playing. Changing articulations by keyboard keys (“key-
switching”) is generally much faster and more convenient. However, even on the largest keyboard
there would not be enough keys to have a dedicated key for each articulations. As discussed in the
Articulate Presets manual, the articulations are therefore arranged into Articulation Banks of 12
articulations each. The different articulation banks for all chromatic instruments are shown in Table
Il in the Appendix and their detailed content as well as the corresponding banks for the percussion
instruments are given in the Articulate Presets Manual.

Based on the concept of Articulation Banks Articulate Tools implement (in addition to program
change messages) a next-generation key-switching solution that allows you to conveniently access
all the articulations in the VSL via a small number of keys (1 or 2 octaves) that switch both banks
and articulations. As already discussed in the Setup section and in more detail in the section on the
Articulate Macro below, Articulate Tools offer several modes depending on how much resources you
can allocate for key-switching. As a minimal requirement to use the key-switching you merely have
to allocate a single key or switch controller (like a sustain pedal or button), which toggles articulation
and bank selection (single press) as well as a lower and upper 1-octave control key range (double
press), so that these octaves can also be used for ordinary playing.

Quick access bank

The quick access bank contains a selection of the most used articulations from all the other banks.
It follows the universal layout introduced by Babylon Wave’s Art Director and is thereby compatible
with nearly every orchestral instrument library on the market. Whereas Art Director implements only
a partial octave of 10 key-switches (C to A), the quick access bank completes the octave by adding
further crucial articulations specific to the VSL. The keyboard layout is shown in the figure, where
the extended articulations compared to the Art Director layout are shown in red. Like for all the other
banks the Articulate Monitor always gives you a complete overview of the layout. As shown in table
Il in the Appendix, due to the additional continuous controllers used by Articulate Presets (Vertical
CC2 and Horizontal CC3) the 1-octave Art Conductor layout gives you access to all key articulations
—and due to 3D-control it even gives you control over the nuances of the performance.

Articulation IDs

Articulate Tools fully implement Logic’s convenient and powerful articulation ID feature! l.e. when
you record a sequence the active articulation (out of the 128 that Articulate Presets offer) is
automatically encoded directly in the note events themselves. Correspondingly no additional Midi
events beside the notes are needed in the sequence for articulation selection. The articulation a
note plays is displayed as clear text in Logic’s editors and the required program change messages
to select the corresponding articulation in VI pro are sent automatically.

Since the Articulate Sets Logic Articulation Sets offer the maximum number of 255 Articulation IDs
you can in Logic’s editors in addition even select all of the most commonly used particular
articulation versions (dynamics, repetitions, ftrills, ...) via additional Articulation IDs: e.g. directly
select a 4s medium decrescendo. Therefore, even in this case no other control events are required
in the sequence and all necessary control events to select the particular articulation version (i.e. in
addition to the program change message also the Vertical & Horizontal controllers or the A/B-
switch) are automatically sent to VI pro.
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Articulation Sequencer

In order to allow you to intuitively play a realistic sequence with numerous articulation changes and
all the detailed nuances realized via Articulate Preset's 3D control in real time, Articulate Tools
introduce the novel concept of an articulation sequencer. Once an articulation sequence has been
recorded, the Articulate Sequencer switches all the particular articulation versions automatically so
that you can concentrate on the crucial timing, phrasing and dynamics of your music! l.e. the goal of
this sequencer is not to replace Logic’s sequencer, but instead to allow you to conveniently and
directly record very realistic musical lines into Logic’s main sequencer, which would otherwise only
be possible by tedious subsequent editing, if at all. All the comprehensive features of the Articulate
Sequencer are described in detail below.
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Articulate Patches

Just select your patch and you are ready to start

Articulate Patches store all the information and settings that guarantee an intuitive use of the
corresponding VSL instrument. Whereas in VI pro a “patch” is the smallest unit, i.e. a single
articulation (version), a Logic patch is by far the most comprehensive data structure and can store
anything related to a given sound (Instrument, Audio & Midi processing, routing, ...). Dedicated
Articulate Patches are available for every Articulate Preset and have identical names as the
corresponding preset. They are conveniently loaded via the patch browser in Logic’s main window.

As soon as you load an Articulate Patch, all instrument specific Articulate Tools are selected and
completely set up to control the corresponding instrument, so no further manual set-up is required
at all. In particular, selecting the Articulate Patch automatically ...

+ loads the corresponding Articulate Preset in VI pro (including countless “VSL patches”)

+ selects the respective Articulate Monitor for the instrument and the corresponding Articulate
Script that drives it

« enables the respective Articulate Set
+ selects the appropriate Logic instrument icon

+ selects the appropriate Logic Score Style for the corresponding instrument (In the basic
orchestra templates there is also an Instrument Set so that every instrument is automatically
correctly displayed in Logic’s Score Editor. You can surely use your own Instrument Set instead
or adapt it to your needs, in order to obtain the desired score representation and printout.)

+ As part of the above basic orchestra templates it also includes a send to a corresponding group
bus (Strings, Woodwinds, Brass, Percussion) so that you can conveniently control (e.g. solo,
mute or process) whole instrument groups

To not distort the pristine VSL samples, Articulate Patches do not include any additional audio
processing (equalizer, effects, ...). In case you use MIRx the room placement and reverberation is
already done within VI pro itself. In case you want to use other audio processing, simply include the
corresponding plug-ins in the channel strip. In general even though everything is already fully set up
and ready to start you can surely adjust all audio and Midi aspects of Articulate Patches to your
needs (e.g. change the score style, ...). Simply load the patch for the corresponding instrument
make the required changes in the instrument track and save the patch under a different name and/
or at a different location.

Articulate Patches are included for all main Articulate Presets. In case you want a patch for one of
the alternative versions of an Articulate Preset, simply load the corresponding Articulate Patch, then
load the alternative version of the corresponding Articulate Preset in Vienna Instruments Pro and
save the Articulate Patch under a different name and/or at a different location.
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Articulate Monitor

Complete overview of the entire VSL

The Articulate Monitor Smart Controls Panel gives you complete overview of all the sounds in the
VSL just when and where you need it: namely right when selecting articulations directly in Logic’s
Main Window! As the name suggests, the panel is a pure monitor that is controlled by external Midi
events and does not send Midi events to control VI pro itself. Each VSL instrument track has its own
Articulate Monitor. After loading an instrument patch everything is already fully set up and, if not
shown yet, you can simply view the Articulate Monitor for the corresponding instrument by selecting
View > Show Smart Controls (B) from Logic’s main menu.

There are two alternative styles for the Articulate Monitor: wood or metal. Depending on the
material, the corresponding orchestral instrument is mainly made of, either of the two styles is used.
Both have the identical layout and work exactly the same way.

The Articulate Monitor contains the following display elements:

Switch: This button on the upper left lights up when the bank switch controller or a bank key is
pressed. You can also press it with the mouse to see the list of available banks.

Bank: This panel on the lower left shows the currently active bank. You can also change it with the
mouse to see the list of articulations in another bank.

C to B: This octave of keyboard keys in the middle is divided up into two columns with associated
panels that show either the articulations of the currently active bank or the list of available banks
when the bank controller or a bank key is pressed.

Ver & Hor: These two panels on the right show for the selected articulation the effect of the Vertical
and Horizontal controllers.

Sec: This panel shows for the selected articulation, which two section sizes are blended by the
section controller or otherwise for which sampled section the corresponding articulation is
exclusively available. In case of the Dimension Libraries, where the Section Controller generally has
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the same effect for all articulations and at the same time offers a more advanced functionality, this
panel even shows the currently selected section size (with auto-divisi), the particular group or the
individual desk or player. l.e. the display changes as you change the Section Controller and gives
you a full overview of the various options the Section Controller offers for these libraries.

A/B: This panel shows for the selected articulation the assignment of the A/B switch.

Seq: This panel shows the status of the articulation sequencer, i.e. in which of the different transport

modes (O O QZ@ OO OQ) it is, and in the record modes it also shows which control
events (ﬁ, Q Q @ @) are recorded —see the Articulate Sequencer section for details.

Step: This panel shows the current discrete sequencer step. Each step in the articulation sequence,
which stores only the program change message and controllers to select a particular articulation
version, corresponds to a musical note.

Owing to the used Smart Controls theme, all the panels on the right are graphically likewise
arranged next to half an octave, but this has no meaning and these elements are not controlled by
the corresponding keys, but change automatically when an articulation is selected, the Articulate
Sequencer is activated, or in case of the Dimension Libraries when the Section Controller is dialed.

Via the panels next to the keyboard octave in the middle, the Articulate Monitor gives you full
overview of the articulations in the current bank (or the available banks) that can be selected directly
by the corresponding key of the control key range on your corresponding keyboard controller. A

checkmark shows the currently active articulation and you will see it move when you switch

from one articulation to another one. At the same time the panels of the articulation-dependent
Articulate Presets controllers (Vertical (CC2): “Ver”, Horizontal (CC3): “Hor”, Section (CC20): “Sec”
and A/B-switch (CC4): “A/B”) change automatically as well.

Similarly, as soon as you are about to change the bank by either pressing the bank-switch or a key
of the dedicated bank octave on your corresponding keyboard controller you will see the full list of
available banks. As soon as you release the key or bank controller you will see the available
articulations in the current bank again. Switching banks does not switch articulations, yet, or send
anything to VI pro. l.e. when you switch to another bank without switching articulations you will see
that none of the articulations is checked, since the currently active articulation is still in a previous
bank. When you have set up Articulate Tools to work with a switchable single octave and a bank
controller/’key (modes CC(s)+ and Key(s)+, for more details see the Articulate Macro section), the

bank panel also shows the currently active (lower or upper) control key range via the symbols Q
and Q

The articulation panels also show the program change numbers of the corresponding articulations
and you can in addition to key switches also select articulations by program change messages. The
Articulate Monitor switches in this case automatically to the corresponding bank containing the
selected articulation. The controller assignments on the right are always shown for the currently
active articulation and automatically switch when you select another one.
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The “Switch” button and the “Bank" panel can also be controlled with the mouse/trackpad, in order
to display the list of available banks as well as the articulations within another bank. However, this
does not actually select articulations or banks. All other panels are changed remotely by the
Articulate Macro in response to external Midi events and are not meant to be altered via mouse/
trackpad. Under the hood, the Articulate Monitor is driven by Articulate Scripts in Logic’s Midi-
Scripter Plug-In, which includes among other code the directories of the various libraries. Therefore,
the corresponding Scripter Plug-In, which is already fully set up when you select an instrument
patch, should not be removed!

Articulate Scripts

Articulation directories for Articulate Presets

The Articulate Scripts Logic Midi Scripter codes power the Articulate Monitor just described. They
include the entire articulation directory of a given instrument. In general you will not have to access
them directly since they are part of the various instrument patches that you can conveniently select
from Logic’s patch browser. Not every instruments has its own dedicated Articulate Script, but only
those that have a distinct layout. E.g. all Woodwind instruments follow the same articulation layout,
even for the Special bank, so that a universal Articulate Script is sufficient. All Articulate Scripts are
named “Articulate-Script-#” where # is the name of the instrument or class of instruments it applies
to. The list of currently used Articulate Scripts (as well as Articulate Sets described below) is:

+ Strings S, Strings M, Strings L, Violins D, Violas&Cellos D, Basses D
+  Woodwinds
+  Trumpets, Horns, Trombones, Tubas, Brass D, Low Brass D

+ Harp, Timpani, Cymbals, Drums, Percussion, Bells, Mallets, Glockenspiel, Xylophone,
Vibraphone, Marimba

Owing to the universal Articulate Presets layout the Articulate Scripts for chromatic instruments are
largely similar. Aside from the special bank, containing instrument specific articulations, the different
Articulate scripts include identical or at a least comparable articulations at the same position. This
guarantees, as far as possible, that a sequence plays as expected when moved from one
instrument to another one, which is possible due to the consistency of the VSL across the entire
orchestra. In addition there are dedicated Articulate Scripts for the different percussion Combi
patches (see the Articulate Presets manual for details). These have a different layout and the
corresponding dedicated Articulate Scripts guarantee that even in these cases you get a full
overview in the Articulate Monitor and instant access to everything included in these extensive
libraries without memorizing or searching VSL manuals.

Each Articulate Script contains the information which articulations are available for a particular
instrument or class of instruments, and which not: if an articulation is not available the entry in the
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Articulate Monitor shows “---* so that you immediately see what’s included in the corresponding
library and do not accidentally select articulations that are not present. Nevertheless, the
corresponding Articulate Presets generally contain replacement matrices for missing articulations,
so that a sequence moved from another instrument nevertheless plays as far as possible even if the
corresponding original articulation is missing (see the Articulate Preset manual for details).

Moreover, Articulate Scripts include the particular assignments of the different continuous
controllers for every articulation, which are always shown for the currently selected articulation on
the right of the Articulate Monitor. In cases where different versions of an articulation are available
(e.g. different crescendo times), Articulate Scripts list the particular versions (e.g. 2 to 4s) available
to the corresponding instrument. In case of larger classes (e.g. all Woodwinds) the maximum set of
versions available to the instruments in the class is listed and for a particular instrument the number
of available versions can be smaller. In all cases the individual controller ranges to access the
individual version follow the universal layout described in the Articulate Presets Manual and in order
for a sequence to the be fully transferable to another instrument you should select the appropriate
controller range (e.g. even though for some strings there are no very short crescendo times and you
will get a 2s version already for a controller value of 0, in order that this sequence plays back as
expected for many wind instruments, where short crescendos are available, requires that you select
a controller value between 27-54, see the Articulate Presets Manual for details).
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Articulate Sets
All articulations right at your fingertips

Articulation IDs and Articulation Sets

An Articulation ID in Logic is a property of a note (like its velocity or its length). It stores the
information, which articulation is to be played, directly in the note event itself and automatically
sends the MIDI messages required to access the articulation to a Virtual Instrument. An Articulation
Set specifies the Articulations IDs as well as by which external Midi events they are selected and
which Midi events are sent immediately before the corresponding note to access the articulation.
Currently Logic Articulation Sets support up to 255 Articulation IDs and for each up to 3 different
MIDI messages can be specified, that are sent to the Virtual Instrument. In Logic an Articulation Set
is assigned to a given track at the bottom of the Track parameter panel above the corresponding
channel strip.

Features of Articulate Sets

The Articulate Sets integrate Articulate Presets into Logic and allow you to record and select all
articulations included in the Vienna Symphonic Library (VSL) via Logic's Articulation ID feature.
Using the maximum number of 255 Articulation IDs, Articulate Sets are some of the most
comprehensive Logic Articulation Sets ever created and even allow you to individually access
different sampled versions of an articulation, sending the corresponding program change message
and up to two continuous controllers (CC) to Vienna Instruments pro. Whereas there is a single
Articulate Preset/Patch per orchestral instrument, just like for Articulate Scripts there are only
distinct Logic Articulate Sets for instruments and libraries with different articulation layouts.

The first 128 Articulation IDs give you direct access to all matrices included in Articulate Presets (as
listed in Table lll of the Articulate Presets Manual). These Articulation IDs are automatically encoded
in recorded notes during the recording process and automatically send the corresponding program
change messages to access the corresponding articulation in VI pro during playback. The
corresponding Articulations ID numbers are identical to the Program Change messages used to
access articulations (matrices) in Articulate instruments. l.e. the Articulate Sets have the same
articulation layout as Articulate Presets and Articulate Scripts discussed before and guarantee that
you also get a clear full-text description of the entire content of the VSL in all of Logic’s editors,
allowing you to conveniently view and change articulations. If an articulation is not available for a
particular instrument, the name of the corresponding articulation is given in parentheses, instead of
showing an empty Articulation ID. This is done because if you move a sequence from one
instrument to another one that does not offer a given articulation, you still see which articulation was
used with the original instrument, and can replace it in case the automatic replacement matrix does
not lead to the desired result.

Many matrices include different sampled versions of the corresponding articulation. In this case you
standardly need additional continuous controllers to access them, e.g. for runs CC2 to select the
type (major, minor, whole tone or chromatic), CC3 to select the scale and CC4 to select if the run
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goes up- or downwards. However, the residual Articulation IDs 129 - 255 even give you in Logic’s
editors direct access to the individual versions of the most often used articulations (see Table Il in
the Appendix for details). The VSL is still unmatched when it comes to recorded dynamic
transitions, phrases, ... . They can strongly increase the realism, but for most users they likely sit
unused on their disk since up to now they required a significant effort. With Articulate Presets and
the Articulate Sets, using them couldn't be simpler: for the most important ones (dynamics, trills,
grace notes, fast repetitions, ...) you can simply select a note in Logic's Editors (Score, Piano Roll,
Event) and directly assign the specific articulation version via its full name, e.g. muted medium
decrescendo 2s, from the corresponding menu—everything else is done automatically and no
additional control events are required at all! Logic sends both the program change and up to two
continuous controllers to access the corresponding sampled sound. And due to the consistency of
the VSL and of Articulate Presets all this still works even when you move the sequence from one
instruments to another one.

Many of the matrices in Articulate Presets offer continuous 3D-control of certain parameters
allowing you to gradually shape the sound via continuous controller messages. To do this you can
still add the respective continuous controllers, e.g. to control the vibrato intensity of a particular
dynamic transition. Similarly, due to the limitation to 255 Articulation IDs, for some articulations only
the most often used versions are directly accessible (e.g. only half and whole tone grace notes). In
the rare cases that you want to access the other versions (e.g. larger grace note intervals) or more
rarely used articulations you have to use the generic Articulation ID (below 128) and add the
corresponding continuous controllers.

In order to realize the full implementation of Articulation IDs the Articulate Tools use internally CC79.
This controller does not appear in any sequence so you won’t even realize this, but you should not
use this controller for other purposes.

Directly recording with Articulation IDs

When you record a sequence with Articulate Tools the currently active articulation is automatically
encoded in the Articulation ID of a recorded note and as soon as you stop the recording process
they are displayed as clear text in Logic’s editors. This makes editing very easy since you get an
immediate feedback which note will be payed by which articulation via its full name, whereas the
corresponding program change message involves merely a number and could be far away from a
given note. Moreover the Articulation IDs keeps sequences uncluttered since fewer Midi events
appear in them: in most cases, only the notes are necessary. Last but not least, you can start the
sequence at any point and the individual notes will always play with the correct articulation.

Even though all articulations are generally directly encoded in the Articulation IDs of the individual
notes, due to limitations in Logic, the program change messages are nevertheless recorded in the
sequencer. However, they have no impact in this case, because a dedicated program change
message is automatically sent immediately prior to each note owing to its Articulation ID. Therefore
the explicit program change messages can simply be hidden in Logic’s editors, so that you do not
see them at all, or even removed if you prefer to do so.

That the underlying program change messages are recorded also has the advantage that you have
the choice whether you want to use Articulation IDs or not. In case you prefer to not use Articulation
IDs and work exclusively with program change messages instead, you can completely turn off the
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encoding of articulations into the Articulation ID in the Articulate Macro, described in the
corresponding section below and simply remove the corresponding Articulate Set in the track
parameters.

Editing Articulation IDs

You can view and change the Articulation ID directly in Logic's Editors (Score, Piano Roll, Event).
The Articulate Sets use 4-character abbreviations plus a full description of the articulation. They give
you therefore a clear overview in Logic's editors and at the same time enable a convenient
articulation selection in all pull-down menus. The Articulation ID number itself is not shown but only
the abbreviation and the full name (e.g. "mmd2 : muted medium decrescendo 2s”).

In Logic’s different editors the Articulation ID is accessed as follows:

Piano Roll Editor

Piano Roll Score Step Sequencer Smart Tempo

< O® @) oY 13 kv N v * v
1 13 2 d
|

Edit v Functions v View v

2 Notes selected (E 7)
in Violins

Time Quantize (classic)
1/16 Note
Strength
Swing @

A4
89
trem : tremolo [ fluttertongue / bisbigliando /rolls

Articulation
sus :sustained

Velocity

In the Piano Roll Editor the Articulation ID selector is shown in the Local Inspector to the left. Make
sure that the Local Inspector is visible by selecting “Show Local Inspector” in the local “View”
Menu. Moreover, the height of the Piano Roll has to be sufficiently large for the Articulation ID
selector to be displayed. Simply select one or several notes and assign the desired Articulation ID in
the Articulation selector to the note(s) by selecting it from the pull-down menu. You can also check
which articulation is assigned to a given note by hovering with the mouse pointer over the note.

Score Editor

In the Score Editor the Articulation ID is shown both in the Local Inspector (as in the Piano Roll
Editor, see above), and in the Event Inspector, as soon as you select one or several notes. Simply
change the Articulation selector to assign the corresponding articulation to the note(s).

For a few articulations (staccato, pizzicato, ...) the appropriate score symbol is automatically added
when you select the articulation. Similarly, when you add the corresponding score symbol from the
Part Box, the Articulation ID is automatically changed to the corresponding articulation. When there
are several articulations that share the same score symbol—Ilike the standard staccato, staccato
repetitions, muted staccato and muted staccato repetitions—the standard version is used, when
you add the symbol from the part box, and you will subsequently have to change the Articulation
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selector to get one of the other articulations. The support of score symbols in Logic Articulation
Sets is unfortunately still rather rudimentary at this point. It only includes symbols that are attached
to an individual note, but not such that can affect several notes, like legato slurs or dynamic marks.

Event List

When activated in the “View” menu, the Articulation ID is one of the columns of the Event List.
Generally the Event List has rather narrow columns. For an ideal overview, enable in addition to the
Articulation ID only those entries you need in the local “View” menu (e.g. you might not need the
Midi channel) and then adjust the width of the Event List so that the 4-character articulation
abbreviations are fully visible. (If you use locked screensets remember to unlock the screenset

Position Status  Num Articulation Length/Info

mc2... { 020 25

g2 e crescendo 22
sdet... © 010 O

sdet...
Idet...
Sus...
Ista...
sdet...
pizz...
pizz...
pizz...
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trwt...

1
1
1
1
1
1
1
1
1
1
1
1

O O O O OO 0O O O o

before you make the change, and lock it again afterwards.) The Event List then gives you an instant
overview which articulation each note plays. You can also get the full name by hovering with the
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mouse pointer over the Articulation entry. Selecting one or several notes, you can choose the
desired articulation from the pull-down menu via its full name.

Exporting standard Midi files to other DAWs

When you export sequences or an entire project as a standard Midi file, the Articulation IDs, being
an exclusive Logic feature that is not part of the Midi standard, are not directly exported. Yet, Logic
automatically creates the required Midi events (i.e. program change messages and continuous
controllers) for all notes with Articulation IDs when you export a standard Midi file. This works for all
Articulation IDs (both the 128 that can be recorded as well as the additional ones you can assign in
Logic’s editors) and ensures that a sequence is always fully transferable from Logic to other DAWs
(e.g. Cubase)! l.e. it will play exactly the same in the corresponding sequencer when Articulate
Presets are used.

This is particularly useful since Logic’s notation capabilities are behind most of its other features. It
allows you to create a project in Logic, taking advantage of all the powerful possibilities that Logic
and Articulate Tools offer to create the most realistic Midi playback of your music, and then export it
to a dedicated notation program to improve and finalize the score. The fact that Articulate Presets
use program change messages—instead of key switches that would distort the score—guarantees
that this procedure works as expected.

Articulate Sequencer

Bringing your music to life

What is an Articulation Sequencer?

The Articulate Sequencer is a unique concept that is distinct from both Logic’s sequencer and the
Auto Playback and Pattern (APP) sequencer in VI pro. Its purpose is not to replace them, but rather
to perfectly complement them. The only goal of the Articulate Sequencer is to help you record
realistic musical lines with fancy articulation switches in real time into Logic’s sequencer. This is
particularly useful and necessary for Articulate Presets which allow you in addition to switching
different discrete articulations via program change messages also to access different versions of an
articulation or intermediate nuances (using Articulate Presets signature 3D control) with the help of
additional continuous controllers. For instance the user can select a strong dynamics articulation
(PC56) and then specify that it has a length of 2s (via CC2), that it is a decrescendo (via CC4), that it
is played with just a bit of vibrato (via CC3), and finally that it is played by an intermediate size
instrument section (via CC20). It would obviously be impossible to send a program change message
and four additional controllers before each note in real time during fast passages with many
articulation changes.

In addition to the appropriate articulation version, when playing/recording a musical line there are all
these subtle but crucial timing, phrasing, and dynamics variations that distinguish the performance
of a virtuous instrumentalist from the same set of notes played by a computer. These variations, that
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are intuitively added during real time playing, bring a performance to life. Yet, they are extremely
hard to restore subsequently by editing of plain, quantized Midi data. At the same time, it is likewise
nearly impossible to play a musical line realistically when using the wrong articulation version: just
think of trying to play a romantic legato strings melody with a staccato articulation or the other way

around a fast, rhythmic staccato pattern with a legato articulation &. So when recording a

sophisticated musical line using various different articulations you would ideally want some magic
tool that always automatically provides you with the appropriate articulation version for each note
and thereby allows you to concentrate on the additional nuances of the performance (timing,
phasing, ...)—that’s exactly what the Articulate Sequencer does!

The idea is that you record in a first take the control events into the Articulate Sequencer, by simply
playing the musical line with all the program and controller changes. This can be done as slowly as
necessary, or even step by step, and the detailed timing, phrasing, ... does not matter at all since
the Articulate Sequencer only records the control events required to select the particular articulation
versions for notes of the musical line, but not the actual notes themselves. l.e. in contrast to an
ordinary sequencer the Articulate Sequencer does not record any timing information (i.e. when these
events are played), instead the Midi events necessary for articulation selection are sent whenever
you send the corresponding note and then determine how this note is played (e.g. the 5th set of
events, stored in the 5th step of the sequencer, is send whenever you send the 5th note of your
musical line from your keyboard). After the articulation sequence is recorded you can then in a
second take simply play the line in real time while the Articulate Sequencer takes care of all the
articulation switching, so that you can concentrate on the detailed timing, phrasing, and if
necessary also the dynamics via VSLs Velocity Xfade controller and/or real-time vibrato changes
using Articulate Preset’s Expressive Vibrato (xVib) matrices (see below).

Like the next-generation key-switching, the Articulation Sequencer is powered by the Articulate
Macro and its display elements, showing the currently active sequencer mode and the current
sequencer step, are integrated in the Articulate Monitor driven by Articulate Scripts. It is exclusively
controlled by external Midi events like keys or controllers.

Features of the Articulate Sequencer

The Articulate Sequencer is kept as elementary and easy to use as possible: it only offers a single
sequence of up to 127 steps, which is even global and shared by all tracks. As mentioned before,
this sequence does not record actual Midi notes, but merely the control events to select the
particular articulation version an associated note will use. With Articulate Presets you cannot only
select a few discrete articulations via program change messages (PC) or the corresponding key-
switches, but for most articulations you have the chance to dial the nuances of the performance by
other (quasi-)continuous controllers (Vertical CC2, Horizontal CC3, Section CC20 and A/B switch
CC4). In the following we refer to this set of five midi events events (PC, CC2, 3, 4 & 20) as control
events and the Articulate Sequencer can record all of them. l.e. each step—corresponding to a note
of your musical line—can record a program change message, specifying the articulation, as well as
all the other dedicated controllers (Vertical, Horizontal, Section and A/B switch) used by Articulate
Presets to select the particular articulation version.

As discussed before, the program change messages are standardly subsequently encoded into
Articulation IDs and are not required in Logic’s sequences anymore. Nevertheless the program
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change messages are the primary Midi events that are stored in the Articulate Sequencer, (which, as
part of the Articulate Macro, is located in the Midi flow before Logic’s sequencer) and therefore we
refer here to the program change messages, even though you generally only have to deal with the
corresponding Articulation IDs in Logic’s sequences.

The single sequence of the Articulate Sequencer is not meant to be set in stone, but is merely a
temporary tool that is stored only until you recorded the corresponding musical line safely into
Logic’s sequencer ... and it is overwritten the next time you use it again for another line. All its
features can either be controlled by a single Midi switch controller (foot switch, button, ...)
respectively a single keyboard key, or a range of three controllers or keys.

Since the set of control events stored in the n-th step of the sequencer is associated to the n-th
note in your musical line, you cannot omit notes when you record or play the sequence, because
this will lead to unwanted results. The musical line can be polyphonic and in particular can without
difficulty contain chords, if the different notes of the chord are to be played with the same
articulation. Yet, take into account that each note counts as a step. In the special case that your
sequence contains chords and you want the individual notes played by different articulations you
have to make sure that you play the individual notes in the same order during both takes (i.e. when
recording the control events into the Articulate Sequencer and when eventually recording you
musical line into Logic’s sequencer). This can be achieved by very slightly displacing the different
notes of the chord in the same way (i.e. very quickly, and thereby unnoticeably, arpeggiating them).

Most Articulate Presets offer Expressive Vibrato (xVib), Expressive Mute (xMute) or Expressive
Tuning (xTune) matrices. These are on PC4, 16, 76 & 88 and allow to control the corresponding
property—in particular vibrato—with the Section Controller in real time while a note is playing,
instead of merely setting the version that is to be played when the note is triggered. Therefore for
these particular Expressive matrices (PC4, 16, 76 & 88) the Section Controller is automatically not
sent at the time a note is triggered, so that you can instead record the continuous controller data in
real time while you record your musical line into Logic.

Articulate Presets contain many matrices with phrases, which are either pre-recorded or are realized
via the Auto Playback & Pattern (APP) Sequencer included in VI pro. The Articulate Sequencer also
fully supports these and therefore allows you to use all three sequencers (Logic’s main sequencer,
APP sequencer & Articulate Sequencer) simultaneously, to create orchestral mockups that are as
close to a real orchestral performance as possible.

Controlling the Articulate Sequencer

The Articulate Sequencer can either be controlled by a single key or continuous controller
(analogous to the bank controller) or by three corresponding control elements, i.e. either keys or
CCs (see the Articulate Macro section for details). You can access the different sequencer transport
controls depending on either how often you press the single control element in a row (without
playing an ordinary note in between) or by pressing the dedicated control elements.

Single-press or first control element: Toggles Q play on/off

Double-press or second control element: Toggles O record on/off, but this does not automatically
start the sequencer transport
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Triple-press or third control element: @ Skip to start, i.e. this stops both play and record (if active)

and rewinds the sequence to the beginning (the step display will show step 0, but it is not part of
the sequence, which only starts with step 1)

In order that the Articulate Sequencer can distinguish single- or double-presses when using a single
control element, you have to play ordinary notes in between.

With these controls you can set the sequencer into various transport modes, that even include
different record modes, all of which are displayed in the “Seq” panel of the Articulate Monitor:

O Stop:

In stop mode the articulation sequencer is inactive and you can (and have to) change articulation
versions yourself. If you change an articulation version the corresponding control events, i.e. the
program change (PC) message and the dedicated continuous controllers (CC2, 3, 4, 20) used by
Articulate Presets are nevertheless buffered (outside of the articulation sequence) so that the
sequencer knows at all times what the currently active articulation version is. And these most recent
buffered values are also used in Replace recording mode, described below.

Q Play:

In play mode the sequencer automatically plays back the articulation switches as you play the notes
of your musical line. l.e. it sends immediately before each note the five associated control events
that have been previously stored in one of the record modes described below. In Play mode you
cannot change articulations manually at all, because whatever changes you make before you press
a note key, they will be altered again by the stored values in the articulation sequence that are sent
immediately prior to the note. When the sequence reaches its end in play mode it will start again
from the beginning.

Oz@ Recording setup: Turn on record when in stop mode

In recording setup mode no data is recorded, yet. It merely allows you to activate certain control
events for Replace recording. You could think of this as activating certain tracks for multi-track
recording in your DAW. Simply send the corresponding control events to activate them. The active

control events are shown by corresponding symbols (program change: ﬁ vertical controller (CC2):

Q, horizontal controller (CC3): Q section controller (CC20): @ A/B-switch (CC4): @) in the

Articulate Monitor. The values of the control events you send are also buffered and will be used in
Replace recording mode, described below, until you send them again. Pressing any note
deactivates all control events for Replace recording.

QQ Replace recording: Activate play after record has been activated

In Replace recording mode all control events that have been activated in Recording Setup mode (or
simply all of them if you did not make a selection) are stored in the current step, overwriting
previously stored data by their present value (i.e. the last value you had adjusted before), even if you
did not actively send these control events in the current step. Thereby anything that was stored in
the sequence before is replaced and overwritten for the activated control events. While activating
Replace recording mode you will automatically pass through Recording setup mode, but It is not
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necessary to select particular control events for recording. If you leave record setup mode without
activating any events (e.g. by directly pressing record and play), all control events will be activated
and set to neutral values of zero (see below for more details).

OO Adjust recording: Activate record while the sequencer is playing

In Adjust recording mode the control events are only altered if you send them in the current step. If
not they remain at the value that had been stored in the sequence before. l.e. only those events in
the sequence are overwritten, that you actively change by altering their value during the current
step. The control events that will be changed in the current step are shown in the Articulate Monitor.

In both of the two recording modes play and record are activated, and which mode is realized
depends only on the order in which they are activated. Replace Recording mode is entered from
Recording setup mode by a single press of the sequencer control element (activating play) and
Adjust recording mode is entered from Play mode by a double-press of the corresponding control
element (activating record). When you reach the end of the sequence in either Replace or Adjust
recording mode, record is automatically deactivated and the sequence plays from the beginning.

When you change the articulation or any of the controllers they are not immediately recorded (in the
record modes). Instead they change a buffer (in any transport mode, i.e. even in Stop mode) and
only once you play the corresponding note, buffered data is actually stored in the current step of the
articulation sequence (in the record modes). l.e. you can still stop the recording process without
changes if you realize that you sent a wrong control event in the present step and did not press the
note, yet.

Using the Sequencer

Replace recording (OQ) is the standard recording mode. It works like a step sequencer (similar to

a tape machine) that only records the control events selected in Recording setup mode and
replaces whatever was present in the sequence before. You can simply press record and play your
melody line once with the corresponding control events that change the articulation version. The
tool stores all changes in the process and can perform them automatically in subsequent
performances of the melody so you can concentrate on other aspects of the music.

If you want to keep it simple and do not want to dive into the advanced features of the sequencer,
all you need to remember is that you always have to activate first record and then play (starting the
sequencer transport) to start recording. In case you do not make further adjustments in Recording
Setup mode all 5 control events are recorded and the buffers are set to neutral values of zero. This
is called simplified replace recording mode and it is what you typically want to use when you record
a new sequence from scratch.

Since even with sufficient time it can be hard to keep track of 5 different control events in each step,
by selecting only a single or some control events for replace recording you can also record the
different events in different takes (e.g. first the program change messages and then the individual
controllers). This way you can record the different control events one by one (similar to
consecutively recording different tracks in multi-track recording). Control events that have been
recorded before and are not activated for recording, already play back correctly so that you can
successively refine your sequence. This is particularly useful for Articulate Preset’s 3D control: you
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can for instance first record the distinct articulations (ﬁ, and where necessary @) and then adjust

the nuances (by adding the (quasi-)continuous controllers Q Q and @ one by one). To do this
you should when you start recording a new sequence from scratch nevertheless record all five

control events in simplified replace recording mode to overwrite the 3D control events (Q, Q and

@) with neutral values.

Adjust recording (QQ) is very useful to improve and change parts of a previously recorded

sequence. You can play the sequence to the point where you want to make changes, activate
record, alter only those control events that you want to change and deactivate recording again.
Everything else will remain unchanged. In adjust recording mode you do not have to activate tracks
for recording and the settings made in record setup mode don’t apply to it. Instead, all control
events can be changed in the present step when you send the appropriate control event.
Nevertheless, as long as you do not send any control events Adjust recording is just like Play mode
and there is no danger that anything is overwritten. Moreover you will get instant feedback via the

corresponding control event symbols (ﬁ, Q Q @ @) in the Articulate Monitor when you

changed the buffer for a given event and are about to make changes to the sequence in a particular
step. Therefore you can just as well activate Adjust recording right away step through your
sequence and make all required changes at various places without deactivating recording in
between. If you realize in the Articulate Monitor that in Adjust recording mode you have accidentally
sent a control event that you do not want to change, you can still prevent it from being overwritten
by stopping the recording process.

Due to the universal layout of Articulate Presets you can use the same articulation sequence to
record the same musical line for different instruments if you want them to play it unisono or
successively at different points in the same piece of music. In contrast to simply copying the entire
Midi sequence in Logic, you can this way still take into account that different instruments behave
slightly differently in general (more or less agile) and with respect to velocity or velocity Xfade in
particular, and this way get the best possible result, without significantly more effort. However, since
the Articulate Sequencer has only a single articulation sequence, that is always overwritten, you will
have to do this right away, before you record a different articulation sequence.

It is important to note again that the Articulate Sequencer is global (as part of the Articulate Macro
that affects all Midi events before they even reach Logic’s sequencer). It has only a single sequence
and also a single buffer, which are used for all tracks! Therefore, when you switch to a different
instrument, the control events that are buffered will reflect the current state of the previous
instrument, but generally not yet the state of the instrument to which you switched. Therefore,
Recording setup mode generally requires you to set these buffers to the appropriate values when
you activate the control events that you want to record. In particular when you start to record a new
sequence for another instrument you have to send the appropriate values of the control events
while selecting them—even if the desired articulation and controller values are already active in the
corresponding track()—so that everything is consistent when you start recording in Replace
recording mode. This is particularly important in case you do not have the VSL licenses to access all
content of a particular Articulate Preset and e.g. cannot use the Section Controller. In this case you
will have to make sure that the Section Controller is buffered with a value of zero before you start
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recording, since otherwise this will lead to undesired results. Yet, when you use simplified replace
recording mode and do not select particular control events in Recording setup mode (and thereby
do not manually update the buffers) all control events are automatically set to neutral values of zero
to prevent glitches.

Articulate Macro

The processing engine under the hood

The Articulate Macro Logic Environment Macro provides the processing necessary to realize both
the next-generation key-switching, the complete overview over your sounds via the Articulate
Monitor, and the Articulate Sequencer. But once set up you generally do not have to care about it
anymore. You can access the Articulate Macro via the Clicks & Ports pane of the Logic’s
Environment window. It has to be inserted in between Logic’s Physical Input and the Sequencer
Input and thereby affects incoming Midi data before they even enter Logic. Based on key switches it
creates e.g. the appropriate program change messages used by Articulate Presets, so that the key-
switch notes do not even reach Logic’s sequencer or could appear in the score. Moreover, it sends
further control events that enable the functionality of the Articulate Monitor and of the Articulate
Sequencer directly in Logic’s main window.

Vienna Instruments

sl

. Sequencer Input
Oct | Key | CC | Chal| Lo-Oct-Hi| Cha | PC ID |[ Mode | Key | CC | Cha

Articulate Macro v1

Physical Input

Logic’s environment is project specific and therefore the Articulate Macro has to be present in your
project in order to offer the functionality provided by Articulate Tools. This way the Midi processing
in other projects that do not require VSL orchestral instruments is not affected at all by the Articulate
Macro. Incorporating the Articulate Macro is most conveniently done by using a template including
the fully set up Articulate Macro, when you create a new project, but you can also add the Articulate
Macro to existing projects, as described below.

The Articulate Macro does not have dedicated control or display elements that you would have to
use one a regular basis, since it is completely controlled by external Midi events and its current
status is shown in the Articulate Monitor, described in more detail below. Nevertheless, it has
various faders that control its general behavior and you could think of them as the “Settings” of
Articulate Tools. l.e. you have to adjust them according to your preferences once, but then you
typically do not have to care about them anymore while using Articulate Tools.
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The Articulate Macro offers three color-coded sections, labeled Bank, Articulation and Sequencer.
The first two set which external Midi events control the next-generation key-switching and the latter
which Midi events control the Articulate Sequencer, as described in more detail below.

Bank Section

The Articulate Macro offers several modes. In all cases you need (at least) one octave of keyboard
keys for key switching. However, in the modes Key 2 and CC 2, explained in more detail below, this
octave is not permanently assigned and can also be used for normal playing. In addition you need
further resources and there are 6 different modes, depending on the resources you can/want to
allocate for key switching:

The environment macro allows you to select which mode to control the next-generation key-
switching you want to use as well as to set up all the detailed settings.

Mode: sets if the next-generation key-switching is active and which Midi events control it

Octave: this is the most convenient option and requires even a second permanently assigned
octave of keyboard keys to switch banks. l.e. you need a separate 2-octave keyboard (or two
octaves on a larger second keyboard) for key switching, where one octave selects banks and
the other one selects articulations. The Articulate Monitor shows in this case the available
articulations in the current bank. Yet, while you press any bank key, it shows the directory of
the available banks instead.

CC: A permanently assigned switch controller (e.g. a piano pedal) changes the, likewise
permanently assigned, octave between bank (when pressed) and articulation selection (when
not pressed)—i.e. the switch controller acts similar to a modifier key on your computer
keyboard. In this case a single octave is used to select both banks (when the switch is
pressed) and articulations (otherwise). This mode typically requires a large keyboard, where
the lowest octave is (exclusively) used for key switching. This only works as long as you do
not use ultra-low instruments (like the contrabassoon) in your music and otherwise you have
to choose CC+ instead.

CC+: This mode is similar to CC, but in this case the octave is not permanently assigned but
you can specify two control key ranges of 1 octave each (a lower and an upper one) and you
use the same switch controller to toggle between the two control octaves: a single press of
the switch controller switches articulations/banks and pressing the switch twice toggles lower/
upper octaves for key switching. You could think of this as a “double-click” on your mouse,
i.e. you press the switch two times in a row without pressing a keyboard key in between.
Important: in contrast to your mouse it does not matter how long the time interval between the
two presses is. The CC+ mode allows you to take advantage of full-featured key switching
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even on a smaller keyboard by using the lower key range for high-pitched instruments and the
upper key range for low-pitched instruments—or, in the rare case that the key-range of the
used instrument actually covers your entire keyboard, depending on which register your music
currently requires.

CCs+: This mode is similar to CC+, but instead of a single continuous controller two
consecutive controllers are used, where on switches bank and articulation selection and the
other toggles lower and upper key ranges. The CC number # of the first controller can be
selected below and the second controller has send CC number #+1.

Key: This mode is analogous to CC explained above. However, instead of a switch controller a
permanently assigned keyboard key takes the role of the bank switch. This way you can use
Articulate Presets even when you merely have a large 88-key piano keyboard by using e.g. the
lowest key on the keyboard (which is very rarely used for orchestral instruments anyway) as a
bank switch as well as the lowest full octave for articulation/bank switching. This can work as
long as you do not use the lowest register of instruments like the Contrabass in your music.

Key+: This mode is analogous to CC+ explained above. Another key is permanently assigned
to toggle the switchable octave between articulation and bank selection (when pressed once)
and at the same time between an upper/lower octave (when pressed twice in a row). l.e. a
single octave is used to select both banks (when the key is pressed) and articulations
(otherwise).

Keys+: This mode is analogous to CCs+ explained above. Two adjacent keys are permanently
assigned to switch bank/articulation selection and toggle lower/upper range, respectively. The
first key can be selected below.

Off: The next-generation key-switching is deactivated. You can chose this if you don’t have
the necessary resources for key-switching (e.g. if you use a small keyboard on the go) and are
fine with selecting articulations by program change messages. You will in this case
nevertheless get full overview via the Articulate Monitor and even the Articulate Sequencer
described below can be used.

Oct: sets the bank selection octave (only available in Octave mode)

Key: sets either the single bank selection key (in Key, Key+ modes) or the lowest of the two keys
that control the key-switching (in Keys+ mode)

CC: sets either the single bank selection (in CC, CC+ modes) or the controller number of the lowest
of the two switch controllers that control the key-switching (in CCs mode)

Cha: sets the Midi channel on which all bank selection events are accepted (all modes)

Important: All CC modes require switch controllers that behave like a sustain pedal: i.e. send a
non-zero controller value when pressed and a value of zero when released again (similar to a
keyboard key sending a note-on/-off pair). On many master keyboards it can be specified how a
given switch controller (pedal, button, ...) behaves and the appropriate mode is typically called

tE 11

“momentary”, “instantaneous”, or similar.
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Articulation Section

Lo-Oct-Hi: the left field sets the single or lower control key range octave for articulation (and bank)
selection, the right field is only available in CC(s)+ and Key(s)+ modes and sets the upper octave for
articulation and bank selection

Cha: sets the Midi channel on which articulation selection key switches are accepted

PC: sets an offset of -1 for program change messages that are sent directly from your master
keyboard (not those resulting from key switches) - you will have to activate it if you realize an offset
between the program change messages sent from your keyboard and those displayed in the
Articulate Monitor (since selecting the first program on your keyboard sends PC1 instead of the
lowest value PCQ). l.e. this button does not active program change message, but they are always
accepted even when key-switching is turned off via the Mode menu.

ID: must be activated if you want to encode articulations directly into Articulation IDs when
recording sequences. This is standardly the case in all Articulate Templates and Articulate Patches
and requires an Articulate Set. You can uncheck this checkbox if you do not want to encode
articulations into Articulation IDs and rather want to use program change messages. In this case
you will have to remove the corresponding Articulate Sets from the track parameters of all your
tracks. This button is active even when key-switching is turned off via the Mode menu.

Standardly the entire Physical Input, i.e. the sum of all ports, is transmitted through the Articulate
Environment Macro. If you have several Midi inputs, you can also cable the Midi routing so that only
certain Midi ports are transmitted through the Articulate Macro—see the Logic documentation for
details.

Although, it is standardly assumed that articulations and banks are selected by a range of keyboard
keys, you could likewise use a set of 12 drum pads or assignable physical buttons on your master
keyboard—or even virtual keys or buttons realized in a tablet or smartphone app, in case they can
be configured to send Midi note events.

Sequencer Section

Mode: sets if the Articulate Sequencer is active and which Midi event(s) control(s) it—see the
Articulate Sequencer Section for more details.

Key: A single keyboard key is permanently assigned to control all functions of the sequencer.
A single press toggles play/pause. A double-press toggles record on/off and a triple-press
skips to the beginning of the sequence, i.e. stops record and play and rewinds the sequence
to step 0. Since this key is fixed and cannot be used for ordinary playing at all, you should
only assign the lowest or highest key if you have a large main keyboard.

Keys: Three adjacent keyboard keys are permanently assigned to control the sequencer. The
key set by the key fader to the right toggles play/pause. The next higher key toggles record
on/off and the next key skips to the beginning of the sequence, i.e. stops record and play and
rewinds the sequence to step 0. Since these keys are used exclusively to control the
sequencer and cannot be used for ordinary playing, you should only assign the lowest or
highest keys if you have a large main keyboard.
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CC: A single switch controller is permanently assigned to control all functions of the
sequencer. A single press toggles play/pause. A double-press toggles record on/off and a
triple-press skips to the beginning of the sequence, i.e. stops record and play and rewinds the
sequence to step 0.

CCs: Three consecutive switch controllers (e.g. the pedals on a digital piano or a range of
buttons on you master keyboard) are permanently assigned to the sequencer. The controller
set by the CC fader to the right toggles play/pause. The next higher controller number toggles
record on/off, and the next higher controller number skips to the beginning of the sequence,
i.e. stops record and play and rewinds the sequence to step 0.

Off: The Articulate Sequencer is completely deactivated.

Key: sets either the single key (in Key mode) or the lowest of the three keys that control the
sequencer (in Keys mode)

CC: sets either the single switch controller (in CC mode) or the controller number of the lowest of
the three switch controller that control the sequencer (in CCs mode)

Cha: sets the Midi channel on which sequencer control events are accepted

Adapting Articulate Tools to your system

As just discussed Articulate Tools offer different ways for key switching and sequencer control, that
should be chosen depending on your Midi hardware, and the options range e.g. from a single small
keyboard for both playing and key switching to a separate two octave keyboard exclusively for key
switching. You only need to deal with the Articulate Macro when you want to adapt Articulate Tools
to your system. This only has to be performed once and afterwards you can safe the project
containing the customized Articulate Macro as a custom template.

To do so you can start with a project based on one of the Articulate Tools factory templates. If you
already have a custom Logic template see the next section on how to integrate the Articulate Macro
into it. In the corresponding project open an Environment window, select the Clicks & Ports layer
and you will see the Articulate Macro. Make the required changes to the parameters discussed in
detail in the preceding sections and then safe this project as a custom template by choosing

File > Save as Template...

from Logic’s main menu. Name the template accordingly and it will be available the next time you
start Logic or create a new project from a template.

Including the Articulate Macro into existing Logic projects

If you already have your own Logic template or old projects that you want to use with Articulate
Tools, you can include the Articulate Macro into them to do so. There are basically two ways to do
this:

+ If you haven’t made any changes in the environment of your project, you can simply import the
Clicks & Ports layer of a Logic project based on one of the factory Articulate Tools templates or
your personal Articulate Tools template. To do this select in the Environment submenu
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Options > Import Environment > Import Layer
select the corresponding project as well as the Clicks & Ports layer in the pop-up menu and
press the Import button.

* If you already made changes in the Clicks & Ports layer in the environment of the project you
want to use with Articulate Tools, select the Clicks & Ports layer in a project based on one of the
Articulate Tools templates or in your personal Articulate Tools template in which you already
adapted the Articulate Macro to your system, select the Articulate Macro and copy it. Then go to
the Clicks & Ports layer of your project and paste the Articulate Macro. Finally cable it
somewhere in between the path from the Physical Input and Sequencer Input (see the figure
above as an example).

Appendix

List of Articulation IDs & Quick Access bank

Table | lists the different Articulation Banks, the bank selection key to access them as well as the
range of program change messages to access the articulations in these banks, respectively the
corresponding Articulation IDs they are encoded in. The full list of the particular articulations in
these banks is given in the Articulate Presets manual—or directly in the Articulate Monitor.

Table Il shows the detailed layout of the Quick Access bank, including the effect of the different
controllers. The single octave Quick Access bank actually gives you direct access to much more
articulations than explicitly labeled in the articulation column. This is shown in detail in the
Horizontal/Vertical columns in table Il. For instance, the Long articulation (corresponding to
sustained (PC1) in the Articulate Presets / VSL terminology) allows you for wind instruments to blend
from sustained to long portato and eventually to (single-note) marcato by changing the Vertical
Controller, whereas the Horizontal Controller dials the vibrato intensity from strong via light to no
vibrato. Similarly, Short and Staccato give you access to all sampled short note versions. For the
strings, the Legato articulation allows to blend from normal legato via slurred legato to a full-fledged
portamento via the Vertical Controller. The first column of table Il also shows the (program change
and Articulation ID) number of the corresponding Articulate Presets matrix.

Table Il lists the Articulation IDs included in Articulate Sets. The first 128 correspond to the
individual matrices included in Articulate Presets and merely send the corresponding program
change message. The remaining 127 Articulation IDs allow you for articulations that feature several
sampled versions to directly access a particular version without the need for any additional Midi
events besides the note (i.e. also automatically sending the required additional continuous
controllers). They cover the most used articulations: in particular all dynamics, repetitions and trills
both in standard and muted versions.
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Table I: Articulation Banks

strings, vibrato intensities, dynamic levels, interval speeds) for direct access

custom 121-128 in this (partial) bank you can add your own custom matrices
(by editing the corresponding Articulate Preset - saving it under a new name)

PC /Art ID
| C basic 1-12 includes the basic articulations orchestral instruments offer
“ interval 13-24 contains all performance interval and trill matrices
n D repetition 25-36 contains all performance repetition matrices
phrase 37-48 includes sampled phrases that have an inherent time structure
E dynamics 49-60 includes all sampled dynamic transitions
F special 61-72 contains instrument-specific articulations and correspondingly has a different layout
for different instruments or instrument classes (see the Articulate Presets Manual)
muted basic 73-84 muted standard articulations and dynamics (analog to | and V)
G muted advanced 85-96 muted performance instruments and phrases (analog to Il - 1V)
sequencer 97-108 contains VSL factory matrices that use the APP sequencer of VI pro
individual 109-120 this bank contains patches that are otherwise part of larger matrices (e.g. individual

Xl

us]

quick access = this last bank contains the most used articulations from other banks (see below)

Table Il: Key Switches of the quick access bank, following Art Conductor conventions

Articulation Availability Vertical Horizontal

1 C Long strings / winds sustain normal <> fast attack / vibrato intensity:
sustain < long portato <> marcato strong <> light < none

C# Legato strings / woodwinds ex BCL / normal < slurred < portamento / — (interval speed)
HOs, TB, CTB / other winds  normal <> grace / normal < glissando / —

-
D Marcato all ex TU attack behavior — (interval speed)
12 D# Tremolo strings / tremolo normal <> fast attack / tremolo intensity:
harp / winds bisbigliando / flutter tongue tremolo <> normal
E Spiccato strings S & VI-L/ M, L ex VI <> harsh / — — (interval speed)
n F Staccato violins L / all others long < short A/B: tight | loose / —
5 F# Short Tenuto strings / winds detache long <> short / vibrato intensity
portato medium <> short)
10 G Pizzicato  strings M&L ex VC-M / VC-M / <> col legno <> snap <slow/<>vib. <
VI-S, VC-S / VA-S, DB-S slow /<>secco/—
37 G# Trills strings S&M / L; woodwinds minor 2. | ... | major 3. (4) std. | baroque / — /
recorded ex CBA; HOs, TU, CTU / TRs slow | fast
18 A Trill all ex BTR,BTB,CTB,TU standard | speed — (speed: legato | trill)
performance
Repetitions all legato < portato < staccato — (repetition speed)
B Dynamics all fortepiano < sforzato <> sforzatissimo vibrato intensity
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Table IlI: Articulation IDs of the Articulate Sets

Art. ID Articulation Version Art. ID Articulation Version

1-128 Articulate Presets matrices 161 - 169 crescendo-decrescendo 1s - 10s

129 interval legato standard 170 - 183 strong crescendo 1s - decrescendo 6s
130 interval legato slurred 184 - 195 medium crescendo 1s - decrescendo 6s
131 interval portamento 196 - 207 light crescendo 1s - decrescendo 6s

132 repetitions legato standard 208 - 212 muted crescendo-decrescendo 2s - 8s
133 repetitions legato crescendo zakelzZl muted strong crescendo 1.5s - decrescendo 6s

134 repetitions legato decrescendo preei il muted medium crescendo 1.5s - decrescendo 6s

N

135 repetitions portato standard 33 muted interval legato standard
136 repetitions portato crescendo 234 muted interval legato slurred

137 repetitions portato decrescendo 235 muted interval portamento

138 repetitions staccato standard 236 muted trills half tone

139 repetitions staccato crescendo 237 muted trills whole tone

140 repetitions staccato decrescendo 238 muted repetitions legato standard
141 repetitions spiccato standard 239 muted repetitions legato crescendo
142 repetitions spiccato crescendo 240 muted repetitions legato decrescendo

143 repetitions spiccato decrescendo  FRZEES2ZLS) muted fast repetitions @ 140bpm - 190bpm

144 trills half tone 247 muted repetitions portato standard

145 trills whole tone 248 muted repetitions portato crescendo
146 trills minor third 249 muted repetitions portato decrescendo
147 trills major third 250 muted repetitions staccato standard

148 grace notes half tone up 251 muted repetitions staccato crescendo

149 grace notes half tone down 252 muted repetitions staccato decrescendo

150 grace notes whole tone up 253 muted repetitions spiccato standard

151 grace notes whole tone down 254 muted repetitions spiccato crescendo

ZER G0N fast repetitions @ 140bpm - 220bpm 255 muted repetitions spiccato decrescendo
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